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Introducing Pages, Numbers, and 
Keynote

Originally a suite of software called iWork, Pages, Numbers, 
and Keynote are Apple’s office/business productivity software 
applications. These apps are roughly the equivalent of Microsoft 
Office’s Word, Excel, and PowerPoint in purpose, but they are 
implemented quite differently due to Apple’s different approach to 
design and functionality.

Pages is the word processing and page layout application. You 
can use it to easily create a range of documents from basic letters 
to elaborate brochures and proposals. Pages makes it easier to 
produce polished documents because Apple provides a variety of 
templates that you can start with; of course, your own creativity is 
never limited because you can make any changes to documents 
you wish, even if you start with a template document.

Numbers is the spreadsheet application. You can use it to organize, 
analyze, and present data in tables that can include automatic 
calculations and formulas. From basic budgets to complex business 
analysis, Numbers can crunch the numbers for you. It also has nice 
charting tools that you can use to present your data graphically.

Keynote is the presentation application. You can create 
presentations that include slides you design and format in just 
about any way you can imagine. To keep things interesting for 
the audience and to make the information more meaningful at 
the same time, you can animate your presentations to make your 
information come alive.
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Because they were originally part of a suite, each of the apps offers a similar 
set of tools. This is great because once you learn how to do something in one 
app, you automatically know how to do it in the others. For example, you 
can format text using the same tools in Pages, Numbers, and Keynote. This 
consistent interface makes the software much easier to learn and use than 
applications that don’t have this common approach to the user interface.

Of course, because each app has its own purposes, there are some tools 
in each one that are unique to it. For example, Keynote is the only app 
that offers animation tools because animation really doesn’t apply to text 
documents or spreadsheets.

Another great thing about these apps is that they are designed to work 
together. This makes it easy to share content among the various types of 
documents you create. Suppose you want to include a bar chart showing 
information in a Pages document. You can create that chart in Numbers and 
then copy and paste it into the Pages document.

Speaking of sharing, even more good news is that in addition to the Mac 
versions of these apps, there are versions for iPhones and iPads, too. And 
with an iCloud account, there are also online versions of the apps that you 
can use on any computer with a web browser and Internet connection. So 
not only can you share content across the apps, you can share content in the 
apps on the different devices you use.

As you work through this book, you’ll find out how useful and easy to use 
these great apps are.

Using This Book
This book has been designed to help you learn how to use each app quickly 
and easily. As you can tell, the book relies heavily on pictures to show you 
how the software works. It is also task focused so that you can quickly learn 
the specific steps to follow to do all the cool things that Pages, Numbers, and 
Keynote enable you to do. You can flip to a task that you want to learn and 
follow the steps to learn how to complete it. The figures show you exactly 
where you perform each step on the screen.

The book begins and ends with information that is applicable to all three 
apps starting with Chapter 1, “Working with iWork Documents,” and finishing 
with Chapter 17, “Publishing and Sharing Pages, Numbers, and Keynote 
Documents.” Between those chapters, there are groups of chapters devoted 
to each app.



3Using This Book

Chapter 2, “Working with Text in Pages Documents,” through Chapter 6, 
“Collaborating with Others on Pages Documents,” teach you how to use 
Pages to create great text documents. In Chapter 7, “Developing Numbers 
Spreadsheets,” through Chapter 10, “Finishing and Collaborating on Numbers 
Spreadsheets,” you learn about Numbers. Last but not least, you learn about 
Keynote in Chapter 11, “Developing Keynote Presentations,” through Chapter 
16, “Presenting Keynote Presentations”; those chapters show you all you 
need to create amazing presentations.

Because there is so much commonality between the apps, instead of 
repeating a topic for each app, you see references back to where a topic 
is covered in detail. For example, you learn how to format text in Pages in 
Chapter 2. Because you use the same tools to format text in Numbers and 
Keynote, you won’t find the details repeated for those apps, but you can 
easily use the reference to quickly jump back to the detailed information.

I recommend you start with Chapter 1 because it applies to all three apps. 
From there, choose the first chapter that covers the app that you want 
to start with (such as Chapter 7 if you want to use Numbers) and let your 
interests guide you through the rest of the book. As you move through each 
chapter, your skills quickly grow and you’ll be able to use these apps to 
create amazing documents, spreadsheets, and presentations.



Use photos and other 
images to make your 

Pages documents more 
interesting and effective

The Inspector offers lots of 
tools you can use to improve 
the design of the graphics in 

your documents

You can easily add any photos in 
your iPhoto or Aperture libraries to 

Pages documents
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Working with Photos, 
Graphics, and Other Objects 
in Pages Documents

One age-old and    extremely overused cliché states, “A picture is worth 
a thousand words.” This cliché is used so often because the idea that 
it expresses—that images communicate effectively—happens to be 
true. What the cliché doesn’t say is that pictures alone don’t usually 
tell a complete story. The most effective communication typically 
includes both words and images. As you’ve seen in previous chapters, 
Pages enables you to do a lot with text and tables. In this chapter, 
you learn how to use the app’s great graphics tools to include visual 
elements, such as photos, to enhance both the effectiveness and the 
visual appeal of your Pages documents.

In this chapter, you learn how to include 
photos and other graphics in your Pages 
documents. Topics include the following:

 ➔ Insert Photos and Other Graphics into Pages 

Documents

 ➔ Design the Photos and Other Images in Pages 

Documents
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Insert Photos and Other Graphics into 
Pages Documents

You can     use many different types of graphics in your documents, including 
photos stored in your iPhoto or Aperture library, photos you’ve stored 
in other places on your Mac, images you’ve created and stored on your 
computer, and images you’ve downloaded. (Make sure you don’t violate 
any copyright or other use restrictions if you are going to use a downloaded 
image in a document.)

There are a number of ways you can add photos and other images to your 
Pages documents, including these:

 • Replace an image placeholder with a photo from iPhoto.

 • Add an image from the Media Browser.

 • Drag an image from your desktop into a document.

Each of these options is explained in the following tasks.

But Wait; There’s More
You can      also insert audio and video into Pages documents. Although this isn’t 
useful for documents you deliver in hard copy format, it can be very useful 
when you are delivering electronic documents, such as ones in the PDF format. 
For example, when you are explaining the steps in a process, you can insert a 
video showing those steps into the document. Someone reading the PDF can 
view the video and read the surrounding text. Although this chapter is focused 
on static images, you can use similar steps to place audio or movie files into 
your documents. When you use audio or movie files in Pages documents, you 
should test your final documents, such as the PDF version, to make sure that 
content plays correctly before you distribute them. If possible, also test the 
document on a different type of device you expect your readers to use, such as 
an iPad or a Windows PC.



79Insert Photos and Other Graphics into Pages Documents

Replace an Image 
Placeholder with a Photo 
from iPhoto
Many of        the Pages document templates 
include image placeholders that you can 
replace with your own images.

 1. Click the icon located in the lower-
right corner of the image 
placeholder. The Media Browser 
appears.

 2. Click the Photos tab. You see the 
photos stored in your iPhoto Photo 
Library. Along the left side of the 
browser, you see the sources of 
photos, which are the same as they 
are in iPhoto.

Use Aperture?
If you use Aperture , the Media 
Browser shows the photos in 
your Aperture library. However, 
if you upgraded from iPhoto to 
Aperture as I did, Aperture actually 
uses your iPhoto Library, and the 
Media Browser is currently labeled 
iPhoto. This doesn’t matter so much 
because the browser looks at the 
current photo library no matter 
which of the two apps you use.

 3. Select the source of photos you 
want to browse. The photos in that 
source appear.

 4. Browse the photos in the selected 
source.

 5. Click the photo with which 
you want to replace the image 
placeholder. The photo replaces the 
placeholder. (Note that the image 
placeholder icon disappears.)

1

3 2

5 4
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Searchin’ for Photos in All 
the Right Places
You can search   for photos to 
insert by clicking the magnifying 
glass icon in the upper-right cor-
ner of the Media Browser. Enter 
your search term in the resulting 
Search bar. The photos you see 
in the browser are reduced to 
include only those that relate to 
the term you entered.

 6. Use the tools in Pages to design 
the photo (explained in “Design 
Photos and Other Images in Pages 
Documents” later in this        chapter).

Use the Media Browser 
to Insert Photos into 
Pages Documents
You can      use the Media Browser to 
add a photo to any location in a 
document.

 1. Position the cursor in the 
approximate location where you 
want the photo. (You can easily 
reposition it later.)

 2. Click the Media button on the 
toolbar. The Media Browser 
appears.

 3. Use steps 2 through 5 in the 
previous task to select the photo 
you want to insert into the 
document.

6

2

1
3
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 4. Use the tools in Pages to design 
the photo (explained in “Design 
Photos and Other Images in Pages 
Documents” later in this      chapter).

>>>Go Further
ADD SHAPES TO PAGES DOCUMENTS
You     can add various kinds of shapes to your Pages documents, such as lines, 
curves, circles, squares, and stars. You can add shapes from the templates 
available in Pages and then customize them for your specific use. For 
example, you can change the fill color, resize them, and so on. Working with 
shapes is quite similar to other objects you’ve learned about. Click the Shape 
button on the Pages toolbar. Then browse the available shapes to find the one 
closest to the shape you want to add to your document. Click that shape, and 
it is added at the current location of the cursor. You can then resize the shape, 
position it on the page, and use the shape tools in the Inspector to format it.

4
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Drag Photos and Other 
Graphics from the Mac 
Desktop into Pages 
Documents
The       Media Browser can access only 
photos and graphics stored in iPhoto 
or Aperture. You can place any image 
stored on your Mac into a Pages 
document by dragging it from the 
desktop into the document.

 1. Position the cursor in the 
approximate location where you 
want the photo. (You can easily 
reposition it later.)

 2. Open a Finder window, and 
navigate to the location of the 
photo you want to place in the 
document.

 3. Drag the document from the 
Finder window onto the Pages 
document. The photo is copied 
into the document.

 4. Use the tools in Pages to design 
the photo (explained in “Design 
Photos and Other Images in Pages 
Documents” later in this chapter).

Is Dragging a Drag?
For yet another option, you can add a photo by choosing Insert, Other. Use 
the resulting dialog to move to and select the image file you want to insert, 
select it, and click Open. The image you selected is placed at the current cursor 
location. This option can be easier than dragging because you don’t need to 
deal with positioning the Finder window so that you can see it and your Pages 
document at the same       time.

1
23
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Don’t Have the Image Yet?
In some     cases, you may know you want to use an image in a document, but you 
might not have the final version of that image ready. In this case, you can create 
an image placeholder to create a space for an image and replace the placeholder 
with the final image when it is ready. To create a placeholder, add an image to 
the document and size it as you will want the final image to be sized. Select the 
image and choose Format, Advanced, Define as Media Placeholder. The image 
becomes a placeholder and is marked with the placeholder icon in the lower-
right corner. You can then replace it with the final image, as described in the task 
“Replace an Image Placeholder with a Photo from iPhoto,” earlier in the chapter.

Design Photos and Other Images in 
Pages Documents

You can      design the photos and other images in your Pages documents in a 
number of ways, including the following:

 • Resize photos or images. You     can change the size of images to make 
them fit the page or size them appropriately for their level of detail 
or importance to the content. You can also change the proportion of 
images, but this can have unintended consequences. So be careful about 
changing the size of images out of their original proportions, or you may 
end up with squished or stretched versions.

 • Rotate photos or images. You     can change the orientation of images or 
flip them horizontally or vertically.

 • Style photos or images. You     can use the Inspector to change the 
appearance of photos and images by adding borders, using drop 
shadows, applying a reflection, and changing their opacity. These tools 
enable you to make images more visually appealing and increase their 
impact; they also enable you to express your creativity. Like styling other 
elements, such as text and tables, you can use the built-in styles in Pages 
or create and save your own styles.

 • Mask photos or images. Masking     is useful to remove parts of images 
that you don’t want to appear in a document. Masking is similar to 
cropping except that when you mask an image, you don’t actually 
change the image; rather, you choose the part of the image you want to 
be shown, and the rest is covered over so that it can’t be seen. Masking is 
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nice because it is easy to adjust the mask or simply remove it to display 
the full image again. (This is in contrast to     cropping, in which part of the 
image is actually removed and is no longer available.)

 • Remove background from photos or images. Sometimes an image has      
something in the background that is distracting. You can use the tools 
in Pages to remove the background from images so that the primary 
subject becomes more prominent.

 • Adjust photos or images. Although     Pages isn’t a photo-editing app, it 
does have some basic tools you can use to improve the quality of images 
in your documents. These include adjusting the exposure, contrast, 
saturation, and other aspects of photos. You can also use the Enhance 
tool in Pages to have the app make semi-automatic adjustments to a 
photo. It’s often a good idea to start with the Enhance tool, and if you 
don’t like the changes it makes, you can easily undo them and adjust the 
photo manually.

 • Position photos or images manually. You       usually want photos and 
images to be in the area of text to which they relate. Like other objects in 
Pages, you can manually position photos on a page.

 • Use the Arrange tab to place photos or images. The Inspector’s 
Arrange tab provides tools you use to determine how photos and images 
interact with surrounding text. You can configure photos and images to 
remain on a page or float with the surrounding text. You can also layer 
images, rotate them, and more.

Refer to the following tasks for the details to accomplish each of these     design 
activities.

Shorthand
Because photos are the most likely types of images you add to Pages 
documents, all the examples you see in this chapter use photos. Up to now, I’ve 
referred to photos and images just to make it clear that you can use the same 
information to add images, such as drawings, to Pages documents, too. From 
now to the end of the chapter, I’ll be referring only to photos, but most of the 
rest of the information in this chapter applies to other kinds of images as well.
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Resize Photos in Pages 
Documents
You     can easily resize images in 
documents as follows:

 1. Select the image you want to 
resize.

 2. Drag a selection handle located 
on the photo’s corners to make 
the photo larger or smaller. As 
you drag, a line appears across 
the diagonal of the image, and its 
current dimensions appear next to 
the selection handle you grabbed.

Resizing Other Kinds of 
Graphics
Pages    assumes you want to maintain 
the proportion of photos you add to 
documents. This is not true for other 
kinds of graphics you may use. To 
ensure you maintain the proportions 
of any graphic, hold down the Shift 
key and drag a corner of the image. 
Its proportions are maintained as you 
resize it. If you don’t hold down the 
Shift key, the proportions may not be 
maintained depending on the type of 
graphic you are working with.

 3. When the photo is the size you want 
it to be, release the selection handle.

Be Precise
For more precision in resizing images, select the image you want to resize and 
click the Arrange tab in the Inspector. Use the Size tools to resize the image. 
You can enter or choose the Width and Height dimensions. Check the Constrain 
proportions check box to keep the image at its current proportion when you 
change dimensions. Click Original Size to return the image to the size it was 
when you placed it into the     document.

21
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Rotate Photos in Pages 
Documents
You     can change the orientation of 
images or photos in your documents 
by performing the following steps:

 1. Select the image you want to 
rotate.

 2. Click the Arrange tab of the 
Inspector.

 3. In the Angle box, enter the angle 
with which you want to rotate 
the image; for example, to rotate 
it clockwise by 90 degrees, enter 
-90.

 4. Press Enter. The image is rotated 
by the amount you input.

 5. To rotate a photo, drag the 
Rotate wheel clockwise or 
counterclockwise. As you drag, 
the image rotates, and you see 
the current angle in the Angle 
box.

 6. To flip  an image horizontally, click 
the horizontal arrow.

 7. To flip an image vertically, click 
the vertical     arrow.

2

3

1
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Style Photos in Pages 
Documents
Use     the style tools to add visual 
interest to photos and other images 
in Pages documents.

 1. Select the image you want to 
style.

 2. Click the Style tab in the 
Inspector.

 3. Click the left- or right-facing arrows 
to browse the available styles.

 4. Click a style you want to apply to 
the photo. The photo is restyled 
accordingly. If you are happy with 
the photo, you can skip the rest of 
these steps.

 5. To manually apply a  border, click 
the disclosure triangle next to 
Border.

 6. Choose the type of border you 
want to apply. The options are Line, 
Picture Frame, and     No Border.

 7. Configure the options for the type 
you selected; when you choose 
Picture Frame, click the frame 
menu.

 8. Click the style of frame you want 
to apply.

 9. Drag the Scale slider to the left 
to reduce the thickness of the 
border or to the right to increase 
it; or use the scale box to enter or 
choose a scale.

 10. To apply a shadow  to the image, 
click the disclosure triangle next 
to Shadow.

1 2

5 3
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 11. On the Shadow menu, choose 
the type of shadow you want to 
apply. The options are None, Drop 
Shadow, Contact Shadow, and 
Curved Shadow. These steps show 
the Curved Shadow option, but 
using the others is similar.

 12. Drag the Inward slider to the 
left or right to determine if the 
shadow curves toward the image 
or away from it and what the 
amount of curvature     should be. 

 13. Use the Offset slider or box to 
change the size of the shadow 
relative to the bottom (using a 
positive offset) or the top of the 
photo (using a negative offset).

 14. Use the Opacity slider or box to 
make the shadow more opaque 
or more transparent.

 15. Use the Angle wheel or box to 
change the angle of the shadow.

 16. Use the Color tool to change the 
shadow’s color.

 17. To apply  a reflection to the image, 
check the Reflection check box.

 18. Use the Reflection slider or box to 
set the amount of reflection.

 19. Use the Opacity slider or  box to 
make the photo more opaque or 
more transparent.

 20. If you want to be able to reuse 
      the styles you have applied, click 
the right-facing arrow at the top 
of the Style tab until you see an 
empty style with the add (+) icon.

 21. Click the empty style to save your 
current style settings.

 22. To apply your custom style, select 
the image to which you want to 
apply it, and click the style you 
    saved.

15 16
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Mask Photos in Pages 
Documents
To     hide parts of photos you don’t 
want to appear in a document, you 
can mask them.

 1. Select the image you want to 
mask.

 2. Click the Image tab of the 
Inspector.

 3. Click Edit Mask. The mask tool 
appears.

 4. Drag the slider to the left to 
increase, or to the right to 
decrease, the size of the photo 
within the frame. The parts of the 
image that won’t be displayed are 
grayed out.

Delete Custom Styles
To delete   styles you’ve saved, perform a secondary click on them and choose 
Delete Style. The saved style is removed.

1 2

3

4
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 5. Drag the selection handles on 
the mask box to change the 
proportions of the box.

 6. Drag the image around inside 
the box to change the part of the 
image that is displayed.

 7. When you’re done making 
changes, click Done. The photo is 
     masked.

5

6 7
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Remove Background 
from Photos in Pages 
Documents
To      remove background elements, 
or any color for that matter, from 
photos, use the Instant Alpha tool.

 1. Select the photo you want to 
change.

 2. Click the Image tab.

 3. Click Instant Alpha.

 4. Drag over areas of color that 
you want to remove from the 
photo. As colors are selected, 
the corresponding parts of the 
photo that will be hidden are 
highlighted in blue. (To remove a 
single color, just click on it instead 
of dragging around.)

Masking photos enables you to focus them 
to show the important parts

1 2 3
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 5. Continue selecting colors to 
remove.

 6. When the image appears as you 
want it to be in the document, 
click      Done.

5

6
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Adjust Photos in Pages 
Documents
Although     Pages isn’t a photo editing 
app, you can do some basic photo 
editing as follows:

 1. Select the photo you want to 
adjust.

 2. Click the Image tab.

 3. Click Enhance to have Pages 
adjust the photo for you. If you 
like the results, you’re done. If 
not, continue to make manual 
adjustments.

 4. Use the Exposure slider and box 
to change the photo’s exposure.

 5. Use the Saturation slider and box 
to change the saturation of the 
colors in the photo.

 6. For even more options, click the 
Adjust Image button. The Adjust 
Image palette appears.

 7. Use the tools on the Adjust 
Image palette to make more 
adjustments to the image.

 8. Close the palette when you’re 
done adjusting the image.

I Take It Back!
Most of the photo tools in Pages 
offer a reset option that you can 
use to undo whatever changes 
you have made. For example, if 
you end up not liking a photo 
better after you have adjusted it, 
click     Reset.

1 2
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Position Photos 
Manually in Pages 
Documents
You      can easily change the position 
of photos and other images in your 
Pages documents by dragging them.

 1. Select the photo you want to move.

 2. Drag the photo around the 
document. As you move it, its 
current location appears in 
the black pop-up box. Yellow 
alignment lines appear to show 
when the photo is lined up with 
something. For example, when 
you see a yellow line down the 
center of the photo, that means 
its centerline is aligned with 
the centerline of the document. 
Alignment lines can appear on 
each side or the top or bottom, 
too. Text around the photo flows 
according to its arrange settings 
(covered in the next task).

 3. When the photo is where you 
want it, release it.

Distribute Graphics
When you have multiple graphics, 
you can distribute them evenly 
across the page. Just select the 
graphics you want to distrib-
ute. On the Arrange tab of the 
Inspector, open the Distribute 
menu and choose how you want 
the images distributed. For exam-
ple, choose Horizontally to have 
the graphics distributed evenly 
across the width of the page.

Position

Alignment 
lines

1 2
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Position Photos Using the Arrange Tab in Pages Documents
Configuring     a photo’s Arrange settings, determine how it interacts with the text and other 
objects on the page on which it appears.

 1. Select the photo you want to configure.

 2. Click the Arrange tab.

 3. If you want the photo to remain on the current page when text is added above it, click 
Stay on Page.

 4. If you want the photo to float so that it remains in the context of the text around it 
when you add text or other content before it, click Move with Text.

 5. On the  Text Wrap menu, choose how you want the photo to interact with the text around 
it. Choose Automatic to have Pages flow the text automatically. Choose Around to have 
the text flow around the top, bottom, and sides of the image. Or choose Above and 
Below to have text flow along the top and bottom of the image but not along its sides.

 6. Use the Text Fit buttons to determine how closely text follows the borders of the 
image. Click the button on the left to have the text conform to the rectangular 
boundary of the image. Click the button on the right to have the text flow to the 
shape of the image. This setting is most useful for shapes and other graphics that 
aren’t rectangular.

1 2
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 7. Use the  Spacing box to set the amount of space between the photo and the 
surrounding text.

 8. Use the  Align menu to align the photo left to right or top to     bottom.

Lock It
To prevent     a photo’s position from changing, you can lock it. Select the photo, 
click the Arrange tab, and click Lock.

7

8
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>>>Go Further
LAYER GRAPHICS
You     can layer photos or other graphics on top of each other. For example, you 
might want to include a smaller photo on top of a larger one, with the smaller 
one showing a close-up detail that is important. To do this layering, place the 
first graphic in your document. Then place the second one. Drag the second 
one on top of the first one. You can repeat this as many times as you’d like. 
To change the order of the stack, use the Back, Front, Backward, and Forward 
buttons on the Inspector.



 Symbols
$ (dollar sign), in cell references 

(Numbers), 179
= (equal sign), in spreadsheets 

(Numbers), 164

A
accepting Track Changes (Pages)

in Comments & Changes pane, 
130-133

inline, 129
accessing iCloud

from Mac, 11-12
from Windows, 12

accounts (iCloud), 8
acknowledging problems in presenta-

tions (Keynote), 331
adding. See inserting
AirDrop, sharing documents (iWork), 

342-343
AirPlay

configuring on iPhone/iPad, 350
for two-display setup (Keynote), 

323, 326-327

aligning
paragraphs (Pages), 38-40
photos (Pages), 96

alternating row colors (Numbers), 153
animation (Keynote), 271-273

builds, 272, 293-295
object animations, 272

editing, 296-298
on/off slides, 286-287
removing, 298-299
within slides, 288-292

preparing slides for, 274
previewing, 276
transitions, 272

creating, 280-283
editing, 284-285
Magic Move transitions, 273-279

Aperture, 79, 249
Apple TV. See AirPlay
apps (iWork)

installing, 347
online versions, 348
opening documents, 349

arranging. See positioning
aspect ratio. See proportions
assigning passwords to documents 

(iWork), 338-339

Index



Index353 attachments (email), size limitations

attachments (email), size limitations, 342
audio files

Keynote, 248, 269
Pages, 78

AutoFill, repeating calculations (Numbers) 
with, 180

axes for charts (Numbers), configuring, 
191-193

B
background

colors/gradients in presentations 
(Keynote), 211

of graphics, removing
in Keynote, 257
in Pages, 84, 91-92

Blank templates, creating iWork 
documents from, 15-16

body rows/columns in tables 
(Numbers), 143

body text. See also text (Pages)
Keynote, 229
Pages, text boxes versus, 29

body text placeholders (Keynote), 211
borders

graphics
Keynote, 255
Pages, 87

headers and footers (Pages), 109-110
table cells

Numbers, 156
Pages, 71

tables (Numbers), 152
text boxes (Pages), 52

builds (Keynote), 272, 293-295
bulleted lists

Keynote
building on slides, 293-295
formatting, 239-242

Pages
formatting text as, 46-47
numbered lists versus, 47

C
cables for two-display setup (Keynote), 

322-325
calculations (Numbers)

deleting, 172
editing, 171-172
explained, 163-165
inserting, 166-168

for range of cells, 169-170
Instant Calculations, 170-171

repeating
with AutoFill, 180
with copy/paste, 181

calculations (Pages), updating, 75
callouts (Keynote), 230

inserting, 234-235
capitalization of text (Pages), 50
captions (Keynote), 230
cells in tables

Numbers, 142
calculations on ranges, 169-170
changing relative/fixed references, 179
formatting, 150, 154-156
inserting data, 150-151
merging, 150, 158
moving, 147-148
relative versus fixed references, 178
selecting, 146-147, 155, 184

Pages
adding content, 59
formatting, 63, 70-72
resizing based on content, 67
selecting, 60-61

change-tracking. See Track Changes 
(Pages)

changing
master slides (Keynote), 214-217

for specific slides, 226-227
passwords in documents (iWork), 339
relative/fixed cell references 

(Numbers), 179
table of contents (Pages), 104
view options for slides (Keynote), 

221-224
volume, 32



354configuring

character styles (Pages), 42-43
creating, 45
updating, 44

charts
Keynote, 248

formatting, 265
inserting, 263-264

Numbers, 183
configuring axes, 191-193
configuring data series, 194-195
copying to presentations (Keynote), 266
formatting, 187-190
inserting, 184-185
moving, 186
resizing, 186
selecting cells, 184

choosing. See selecting
cloud storage

Dropbox, 6
iCloud, 6. See also iCloud
local storage versus, 5-6

collaboration (Keynote)
comments

inserting, 308-309
reviewing, 309-310

sharing via iCloud, 311
collaboration (Numbers)

comments, 205-206
sharing via iCloud, 207

collaboration (Pages)
comments, 121-122

configuring authors, 122-123
deleting, 125
inserting, 124
reviewing in Comments pane, 126-127
reviewing inline, 125
viewing/hiding, 127

sharing via iCloud, 122, 133-139
stopping sharing, 139
Track Changes, 122, 127

disabling, 133
enabling, 128
reviewing in Comments & Changes 

pane, 130-133
reviewing inline, 129
for shared iCloud documents, 134
versions of documents, 133

collaboration in iWork (sharing docu-
ments), 340

AirDrop, 342-343
email, 340-342
iCloud, 343
Messages app, 340

color
background colors/gradients 

(Keynote), 211
table rows (Numbers), 153
tables (Pages), 70
text (Pages), 39, 50

columns in tables
Numbers, 142

deleting, 150, 159
freezing, 158
header columns, 145-146
hiding, 150, 159-160
inserting, 148
moving, 147-148
resizing, 150, 157
selecting, 146-147

Pages
headers, 69
inserting, 64-65
resizing, 67
selecting, 60-61

comments
Keynote

inserting, 308-309
reviewing, 309-310

Numbers, 205-206
Pages, 121-122

configuring authors, 122-123
deleting, 125
inserting, 124
reviewing in Comments pane, 126-127
reviewing inline, 125
viewing/hiding, 127

Comments & Changes pane, reviewing 
Track Changes (Pages), 130-133

Comments bar (Pages), 127
Comments pane, reviewing comments 

(Pages), 126-127
configuring

AirPlay on iPhone/iPad, 350
chart axes (Numbers), 191-193
chart data series (Numbers), 194-195
comment authors (Pages), 122-123



Index355 configuring

dictation, 31-33
dimensions of documents (Pages), 

111, 116
iPad/iPhone for iCloud, 10
iPhone as remote control (Keynote), 

332-333
Mac for iCloud, 9-10
presenter display (Keynote), 315-317
Slideshow preferences (Keynote), 

313-314
two-display setup (Keynote), 322-323

with AirPlay, 323, 326-327
with cable, 322-325

view options for documents (Pages), 
111-113

connections for two-display setup 
(Keynote), 322-323

with AirPlay, 323, 326-327
with cable, 322-325
troubleshooting, 326, 335

constraining images. See proportions
content, adding to tables (Pages), 59
contextual menus, tables (Pages), 66
controlling presentations (Keynote), 

327-330
iPhone as remote control, 334-335
on iPhone/iPad, 350-351

copying
charts (Numbers) into documents 

(Pages) and presentations (Keynote), 
190, 266

repeating calculations (Numbers) 
with, 181

tables (Numbers) to presentations 
(Keynote), 266

text (Pages), 34
cropping photos (Pages), 84
customizing table design (Pages), 69-70

D
data formats for table cells (Pages), 71-72
data series for charts (Numbers), 

configuring, 194-195
date and time in headers and footers 

(Pages), inserting, 107

deleting
background of graphics

Keynote, 257
Pages, 84, 91-92

calculations (Numbers), 172
comments (Pages), 125
filtering rules (Numbers), 204
Magic Move transitions (Keynote), 279
master slides (Keynote), 217
object animations (Keynote), 298-299
page breaks (Pages), 117
passwords from documents (iWork), 339
rows/columns (Numbers), 150, 159
sheets (Numbers), 160
slides (Keynote), 307
styles (Pages), 45, 89
table of contents (Pages), 105
tabs (Pages), 49

designing. See formatting; styles (Pages)
desktop

opening iWork documents from, 21
photos, inserting in documents 

(Pages), 82
replacing placeholders (Keynote), 

250-251
dictation

configuring, 31-33
in Pages, 33

dimensions of documents (Pages), config-
uring, 111, 116

disabling Track Changes (Pages), 133
displaying. See viewing
displays, defined, 320
documents (iWork). See also documents 

(Pages); presentations (Keynote); spread-
sheets (Numbers)

accessing from Windows, 12
creating, 13

PDF versions, 343-345
from scratch, 15-16
from templates, 13-15

exporting, 344-347
managing out-of-sync documents, 

22-23
opening

on iPhone/iPad, 349
from Mac desktop, 21
from Open dialog, 20



356documents (PDF)

passwords
assigning, 338-339
changing, 339
removing, 339

printing, 343-344
saving, 17-19

local versus cloud storage, 5-6
sharing, 340

via AirDrop, 342-343
via email, 340-342
via iCloud, 343
via Messages app, 340

sharing with other apps, 24
opening non-iWork documents in 

iWork, 24-25
saving in Office compatible format, 

26-27
working in iCloud, 7-8

documents (Numbers). See spreadsheets 
(Numbers)

documents (Pages). See also documents 
(iWork)

audio/video, inserting, 78
charts (Numbers) in, 190
comments, 121-122

configuring authors, 122-123
deleting, 125
inserting, 124
reviewing in Comments pane, 126-127
reviewing inline, 125
viewing/hiding, 127

dimensions, configuring, 111, 116
finding and replacing content, 111, 115
footnotes and endnotes, 110
formatting, 111, 119
headers and footers, 105

borders, 109-110
inserting, 106-108
lines in, 106

Invisibles and Layout, viewing, 106, 112
page breaks

deleting, 117
inserting, 111, 117

photos
creating image placeholder, 83
cropping, 84
editing, 84, 93
formatting, 83-84
inserting, 78-82
layering, 97

locking, 96
masking, 83, 89-90
positioning, 84, 94-96
removing background, 84, 91-92
resizing, 83-85
rotating, 83, 86
styling, 83, 87-88

sections, 111
formatting, 118
inserting, 117

shapes, inserting, 81
sharing via iCloud, 122, 133-139
spell-check tools, 111-114
stopping sharing, 139
table of contents, 100

changing, 104
deleting, 105
formatting, 103
inserting, 101-102

tables
adding content, 59
contextual menus, 66
formatting, 61-73
inserting, 58
inserting from Numbers, 74-75
naming, 65
numbering, 66
positioning, 73
selecting, 60-61

text
body text versus text boxes, 29
formatting, 30, 35-50
inserting, 30-34

text boxes, 50
formatting text in, 51
inserting, 51
positioning, 54-55
saving styles, 53
styling, 52-53

Track Changes, 122, 127
disabling, 133
enabling, 128
reviewing in Comments & Changes 

pane, 130-133
reviewing inline, 129
for shared iCloud documents, 134
versions of documents, 133

view options, configuring, 111-113
documents (PDF)

creating, 343-345
sharing via email, 341
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dollar sign ($), in cell references 
(Numbers), 179

dragging
graphics (Keynote), 252
photos (Pages)

into documents, 82
to reposition, 94

resizing rows/columns in tables 
(Numbers), 158

drop shadows for text boxes (Pages), 52
Dropbox, 6

E
editing

calculations (Numbers), 171-172
formulas (Numbers), 177
graphics (Keynote), 257-260
handling feedback, 128
object animations (Keynote), 296-298
photos (Pages), 84, 93
text (Keynote), 236
transitions (Keynote), 284-285

email
sharing documents

iWork, 340-342
PDF, 341

size limitations, 342
enabling

iCloud on Mac, 9-10
Track Changes (Pages), 128

endnotes (Pages), 110
enhancing graphics (Keynote), 259
equal sign (=), in spreadsheets 

(Numbers), 164
error bars in charts (Numbers), 195
errors in calculations (Numbers), 169
exporting documents (iWork), 344-347
exposure of graphics (Keynote), 259
expressions (Numbers), 163

F
feedback from others, handling, 128
fill

table cells
Numbers, 155
Pages, 71

text boxes (Pages), 52
filtering tables (Numbers), 198-204
filtering rules for tables (Numbers), 202-204
finding content in documents (Pages), 

111, 115
fixed cell references (Numbers), 178

changing, 179
flipping photos (Pages), 86
fonts (Pages), formatting, 39
footer rows (Numbers), 143

inserting, 145-146
footers (Pages), 105

borders, 109-110
inserting, 106-108
lines in, 106
in tables, 69

footnotes (Pages), 110
formatting

charts
Keynote, 265
Numbers, 187-190

documents (Pages), 111, 119
graphics (Keynote), 254-256
with Inspector, 34
master slides (Keynote), 237
photos (Pages), 83-84
presenter notes (Keynote), 243-245
Ransom Note Effect, 273
sections (Pages), 118
table of contents (Pages), 103
tables (Numbers), 144, 150-153

cell formatting, 150, 154-156
deleting rows/columns, 150, 159
freezing rows/columns, 158
hiding rows/columns, 150, 159-160
merging cells, 150, 158
resizing rows/columns, 150, 157
text formatting, 150, 156

tables (Pages), 61-64
adding columns/rows, 64-65
applying styles, 68
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cell formatting, 70-72
customizing design, 69-70
resizing columns/rows, 67
text formatting, 72-73

text (Keynote), 236-238
bulleted lists, 239-242
with styles, 234, 237-238

text (Pages), 30, 35-38
advanced options, 50
with character styles, 42-43
creating new styles, 44-45
as lists, 46-47
manually, 38-41
with paragraph styles, 41-42
with Ruler, 48-49
style options, 45
in text boxes, 51
updating existing styles, 43-44

video/audio files (Keynote), 269
formulas (Numbers)

changing relative/fixed cell 
references, 179

creating, 173-176
editing, 177
explained, 165, 172-173
relative versus fixed cell references, 178
repeating

with AutoFill, 180
with copy/paste, 181

freezing rows/columns (Numbers), 158
functions (Numbers)

building formulas, 173-176
explained, 165, 172-173

G
gradients (Keynote), 211
graphics (Keynote). See also photos 

(Keynote)
arranging, 261-262
charts

formatting, 265
inserting, 263-264

editing, 257-260
formatting, 254-256
grouping, 263
inserting, 251-252
masking, 253-254
placeholders, 211

replacing placeholders
from desktop, 250-251
in iPhoto or Aperture, 249

shapes, inserting, 266-268
tables, inserting, 266
types of, 247-248
video/audio files, inserting, 269

grayed-out styles (Pages), 104
grid lines for tables

Numbers, 153
Pages, 70

grouping graphics (Keynote), 263

H
header columns/rows (Numbers), 142

inserting, 145-146
headers (Pages), 105

borders, 109-110
inserting, 106-108
lines in, 106
in tables, 69

hiding. See also masking
comments (Pages), 127
Comments pane (Pages), 126
headers and footers (Pages), 108
Inspector, 34
rows/columns (Numbers), 150, 159-160
Ruler, 38

I
iCloud, 6

accessing
from Mac, 11-12
from Windows, 12

accounts, 8
configuring

iPad/iPhone for, 10
Mac for, 9-10

managing out-of-sync documents, 
22-23

online versions of iWork apps, 348
opening iWork documents from, 21
sharing documents

iWork, 343
Keynote, 311
Numbers, 207
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Pages, 122, 133-139
stopping sharing, 139

working with iWork documents, 7-8
image placeholder (Pages)

creating, 83
replacing, 79-80

images. See photos
indenting paragraphs (Pages), 48
inserting

audio/video (Pages), 78
calculations (Numbers), 166-171
charts

Keynote, 263-264
Numbers, 184-185

columns/rows (Pages), 64-65
comments

Keynote, 308-309
Numbers, 206
Pages, 124

content in tables (Pages), 59
data in tables (Numbers), 150-151
footnotes and endnotes (Pages), 110
functions (Numbers) in formulas, 174
graphics (Keynote), 251-252
headers and footers

Numbers, 145-146
Pages, 106-108

list items (Pages), 47
master slides (Keynote), 217
multiple tables (Numbers), 149
page breaks (Pages), 111, 117
photos (Pages), 78

dragging from desktop, 82
with Media Browser, 80-81
replacing image placeholder, 79-80

presenter notes (Keynote), 243-245
rows in filtered tables (Numbers), 201
rows/columns (Numbers), 148
sections (Pages), 117
shapes

Keynote, 266-268
Pages, 81

sheets (Numbers), 160
slides (Keynote), 219-220
table of contents (Pages), 101-102
tables

Keynote, 266
from Numbers into documents 

(Pages), 74-75
Pages, 58

text (Keynote), 230
callouts, 234-235
creating text boxes, 232
replacing in placeholders, 231
shaped text, 233-234

text (Pages), 30
by copying/pasting, 34
by dictating, 33
by typing, 30-31

text boxes (Pages), 51
video/audio files (Keynote), 269

Inspector, 34
advanced options, 50
formatting tables (Pages), 61-64
text styles, 37

installing iWork apps, 347
Instant Alpha tool (Keynote), 260
Instant Calculations (Numbers), 170-171
Invisibles and Layout (Pages), viewing, 

106, 112
iPad

configuring
AirPlay, 350
iCloud, 10

iWork apps
installing, 347
online versions, 348

opening documents (iWork), 349
presentations (Keynote) on, 348-351

iPhone
configuring

AirPlay, 350
iCloud, 10

iWork apps
installing, 347
online versions, 348

opening documents (iWork), 349
presentations (Keynote) on, 348-351
as remote control (Keynote), 331

configuring, 332-333
controlling presentation, 334-335

iPhoto, replacing placeholders
Keynote, 249
Pages, 79-80

iWork apps
installing, 347
online versions, 348
opening documents, 349
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iWork documents
accessing from Windows, 12
creating, 13

PDF versions, 343-345
from scratch, 15-16
from templates, 13-15

exporting, 344-347
managing out-of-sync documents, 

22-23
opening

on iPhone/iPad, 349
from Mac desktop, 21
from Open dialog, 20

passwords
assigning, 338-339
changing, 339
removing, 339

printing, 343-344
saving, 17-19

local versus cloud storage, 5-6
sharing, 340

via AirDrop, 342-343
via email, 340-342
via iCloud, 343
via Messages app, 340

sharing with other apps, 24
opening non-iWork documents in 

iWork, 24-25
saving in Office compatible format, 

26-27
working in iCloud, 7-8

K
keyboard shortcuts

assigning to styles, 45
presentations (Keynote), 329

Keynote presentations, 209-210. See also 
iWork documents

acknowledging problems, 331
animation, 271-273

builds, 272, 293-295
object animations, 272, 286-292, 

296-299
preparing slides for, 274
previewing, 276
transitions, 272-285

charts
formatting, 265
inserting, 263-264
Numbers charts in, 190

comments
inserting, 308-309
reviewing, 309-310

controlling, 327-330
graphics

arranging, 261-262
editing, 257-260
formatting, 254-256
grouping, 263
inserting, 251-252
masking, 253-254
replacing placeholders, 249-251
types of, 247-248

iPhone as remote control, 331
configuring, 332-333
controlling presentation, 334-335

on iPhone/iPad, 348-351
keyboard shortcuts, 329
master slides, 210-212

changing, 214-217
formatting, 237
viewing, 212-213

outlines, 218
presenter display, configuring, 315-317
previewing, 302-304
rehearsing, 312, 320-321
shapes, inserting, 266-268
sharing via iCloud, 311
slides

arranging text, 243
changing master slide for, 226-227
deleting, 307
editing text, 236
formatting text, 234-242
inserting, 219-220
inserting text, 230-235
moving between, 328
presenter notes, 243-245, 305
reordering, 225
replacing text, 236
replacing title text, 220-221
skipping, 307
view options, 221-224

Slideshow preferences, configuring, 
313-314

spell-check tool, 305-306
tables, inserting, 266
templates, 210
text

arranging, 243
editing, 236
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formatting, 234-242
inserting, 230-235
replacing, 236
types of, 229-230

two-display setup, 312, 320
configuring, 322-327
troubleshooting, 326, 335

video/audio files, inserting, 269

L
landscape orientation (Pages), 116
layering photos (Pages), 97
ligatures (Pages), 50
Light Table view (Keynote), 223
lines in headers and footers (Pages), 106
links, page numbers (Pages) as, 104
lists

Keynote
building on slides, 293-295
formatting, 239-242

Pages
formatting text as, 46-47
numbered lists versus, 47

local storage, cloud storage versus, 5-6
locking

graphics (Keynote), 262
photos (Pages), 96

M
Magic Move transitions (Keynote), 273-279
margins (Pages)

configuring, 111, 116
setting, 48

masking
graphics (Keynote), 253-254
photos (Pages), 83, 89-90

master slides (Keynote), 210-212
changing, 214-217

for specific slides, 226-227
formatting, 237
viewing, 212-213

Media Browser, inserting photos in docu-
ments (Pages), 80-81

menus. See contextual menus

merging cells (Numbers), 150, 158
Messages app, sharing documents 

(iWork), 340
microphones, selecting, 32
Microsoft Office apps, sharing iWork 

documents with, 24
opening non-iWork documents in 

iWork, 24-25
saving iWork documents in Office com-

patible format, 26-27
movies. See video
moving. See also animation (Keynote); 

positioning
between slides (Keynote), 328
charts (Numbers), 186
elements in tables (Numbers), 147-148
slides (Keynote), 225
within tables (Numbers), 145

multiple sheets (Numbers), 160-161
multiple tables (Numbers), inserting, 149

N
naming

styles (Pages), 42, 45
tables (Pages), 65

Navigator view (Keynote), 222
non-iWork documents, opening in iWork, 

24-25
numbered lists (Pages)

bulleted lists versus, 47
formatting text as, 46-47

numbering tables (Pages), 66
Numbers spreadsheets, 141. See also iWork 

documents
calculations

deleting, 172
editing, 171-172
explained, 163-165
inserting, 166-171
repeating with AutoFill, 180
repeating with copy/paste, 181

charts, 183
configuring axes, 191-193
configuring data series, 194-195
copying to presentations (Keynote), 266
formatting, 187-188



362page numbers in table of contents (Pages)

inserting, 184-185
moving, 186
resizing, 186
selecting cells, 184
text formatting, 189-190

collaboration
comments, 205-206
sharing via iCloud, 207

formulas
changing relative/fixed cell 

references, 179
creating, 173-176
editing, 177
explained, 165, 172-173
relative versus fixed cell references, 178
repeating with AutoFill, 180
repeating with copy/paste, 181

functions
building formulas, 173-176
explained, 165, 172-173

multiple sheets in, 160-161
spell-check tools, 205
tables

cell formatting, 150, 154-156
copying to presentations (Keynote), 266
creating, 143-144
deleting rows/columns, 150, 159
elements of, 142-143
filtering, 198-204
formatting, 144, 150-153
freezing rows/columns, 158
hiding rows/columns, 150, 159-160
inserting data in cells, 150-151
inserting headers/footers, 145-146
inserting multiple, 149
inserting into documents (Pages), 74-75
inserting rows/columns in, 148
merging cells, 150, 158
moving elements in, 147-148
moving within, 145
resizing rows/columns, 150, 157
selecting cells, 155
selecting within, 146-147
sorting, 197-200
styles, 145
text formatting, 150, 156

templates, 142

O
object animations (Keynote), 272

editing, 296-298
on/off slides, 286-287
removing, 298-299
within slides, 288-292

object placeholders (Keynote), 214
Office apps, sharing iWork documents 

with, 24
opening non-iWork documents in 

iWork, 24-25
saving iWork documents in Office com-

patible format, 26-27
online storage. See cloud storage
online versions of iWork apps, 348
opacity

graphics (Keynote), 256
photos (Pages), 88
text boxes (Pages), 53

Open dialog, opening iWork documents 
from, 20

opening
documents (iWork)

on iPhone/iPad, 349
from Mac desktop, 21
from Open dialog, 20

non-iWork documents in iWork, 24-25
palettes (Pages), 119

orientation (Pages), 116
out-of-sync documents, managing, 22-23
Outline view (Keynote), 224
outlines

Keynote, 218
tables (Pages), 69

overriding styles (Pages), 43

P
page breaks (Pages)

deleting, 117
inserting, 111, 117

page numbers in table of contents 
(Pages), 104
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Pages documents. See also iWork 
documents

audio/video, inserting, 78
charts (Numbers) in, 190
comments, 121-122

configuring authors, 122-123
deleting, 125
inserting, 124
reviewing in Comments pane, 126-127
reviewing inline, 125
viewing/hiding, 127

dimensions, configuring, 111, 116
finding and replacing content, 111, 115
footnotes and endnotes, 110
formatting, 111, 119
headers and footers, 105

borders, 109-110
inserting, 106-108
lines in, 106

Invisibles and Layout, viewing, 106, 112
page breaks

deleting, 117
inserting, 111, 117

photos
creating image placeholder, 83
cropping, 84
editing, 84, 93
formatting, 83-84
inserting, 78-82
layering, 97
locking, 96
masking, 83, 89-90
positioning, 84, 94-96
removing background, 84, 91-92
resizing, 83-85
rotating, 83, 86
styling, 83, 87-88

sections, 111
formatting, 118
inserting, 117

shapes, inserting, 81
sharing via iCloud, 122, 133-139
spell-check tools, 111-114
stopping sharing, 139
table of contents, 100

changing, 104
deleting, 105
formatting, 103
inserting, 101-102

tables
adding content, 59
contextual menus, 66
formatting, 61-73
inserting, 58
inserting from Numbers, 74-75
naming, 65
numbering, 66
positioning, 73
selecting, 60-61

text
body text versus text boxes, 29
formatting, 30, 35-50
inserting, 30-34

text boxes, 50
formatting text in, 51
inserting, 51
positioning, 54-55
saving styles, 53
styling, 52-53

Track Changes, 122, 127
disabling, 133
enabling, 128
reviewing in Comments & Changes 

pane, 130-133
reviewing inline, 129
for shared iCloud documents, 134
versions of documents, 133

view options, configuring, 111-113
palettes (Pages), opening, 119
paragraph styles (Pages), 41-42

creating, 44-45
updating, 43

paragraphs (Pages)
aligning, 38-40
indenting, 48
spacing, 40-41

passwords
documents (iWork)

assigning, 338-339
changing, 339
removing, 339

requiring
in AirDrop, 342
in email, 341
in exported documents, 346
in PDF documents, 345

sending, 342
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shared documents
Keynote, 311
Pages, 134

pasting
charts (Numbers) into documents 

(Pages) and presentations (Keynote), 
190

repeating calculations (Numbers) with, 
181

text (Pages), 34
PDF documents

creating, 343-345
sharing via email, 341

photos (Keynote), 247
arranging, 261-262
editing, 257-260
formatting, 254-256
grouping, 263
inserting, 251-252
masking, 253-254
replacing placeholders

from desktop, 250-251
in iPhoto or Aperture, 249

photos (Pages)
creating image placeholder, 83
cropping, 84
editing, 84, 93
formatting, 83-84
inserting, 78

dragging from desktop, 82
with Media Browser, 80-81
replacing image placeholder, 79-80

layering, 97
locking, 96
masking, 83, 89-90
positioning, 84, 94-96
removing background, 84, 91-92
resizing, 83-85
rotating, 83, 86
searching, 80
styling, 83, 87-88

placeholders (Keynote), replacing
from desktop, 250-251
in iPhoto or Aperture, 249
text replacement, 231

placing. See positioning
portrait orientation (Pages), 116

positioning
graphics (Keynote), 261-262
photos (Pages), 84, 94-96
tables (Pages), 73
text (Keynote), 243
text boxes (Pages), 54-55

presentation titles (Keynote), 229
presentations (Keynote), 209-210. See also 

documents (iWork)
acknowledging problems, 331
animation, 271-273

builds, 272, 293-295
object animations, 272, 286-292, 

296-299
preparing slides for, 274
previewing, 276
transitions, 272-285

charts
formatting, 265
inserting, 263-264
Numbers charts in, 190

comments
inserting, 308-309
reviewing, 309-310

controlling, 327-330
graphics

arranging, 261-262
editing, 257-260
formatting, 254-256
grouping, 263
inserting, 251-252
masking, 253-254
replacing placeholders, 249-251
types of, 247-248

iPhone as remote control, 331
configuring, 332-333
controlling presentation, 334-335

on iPhone/iPad, 348-351
keyboard shortcuts, 329
master slides, 210-212

changing, 214-217
formatting, 237
viewing, 212-213

outlines, 218
presenter display, configuring, 315-317
previewing, 302-304
rehearsing, 312, 320-321
shapes, inserting, 266-268
sharing via iCloud, 311
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slides
arranging text, 243
changing master slide for, 226-227
deleting, 307
editing text, 236
formatting text, 234-242
inserting, 219-220
inserting text, 230-235
moving between, 328
presenter notes, 243-245, 305
reordering, 225
replacing text, 236
replacing title text, 220-221
skipping, 307
view options, 221-224

Slideshow preferences, configuring, 
313-314

spell-check tool, 305-306
tables, inserting, 266
templates, 210
text

arranging, 243
editing, 236
formatting, 234-242
inserting, 230-235
replacing, 236
types of, 229-230

two-display setup, 312, 320
configuring, 322-327
troubleshooting, 326, 335

video/audio files, inserting, 269
presenter display (Keynote), configuring, 

315-317
presenter notes (Keynote), 243-245, 305
previewing in Keynote

animations, 276
presentations, 302-304

printing documents (iWork), 343-344
problems (Keynote)

acknowledging, 331
troubleshooting, 326, 335

proportions, resizing images (Pages), 85

R
ranges of cells (Numbers)

calculations on, 169-170
selecting, 184

Ransom Note Effect, 273
Recent Effects section (Keynote), 285
reflections

graphics (Keynote), 256
photos (Pages), 88
text boxes (Pages), 53

rehearsing presentations (Keynote), 312, 
320-321

rejecting Track Changes (Pages)
in Comments & Changes pane, 130-133
inline, 129

relative cell references (Numbers), 178
changing, 179

remote control (Keynote), iPhone as, 331
configuring, 332-333
controlling presentation, 334-335

removing. See deleting
renaming

master slides (Keynote), 217
sheets (Numbers), 160

reordering slides (Keynote), 225
repeating calculations (Numbers), 180-181
replacing

content (Pages), 111, 115
graphics (Keynote), 257
image placeholder (Pages), 79-80
placeholders (Keynote)

from desktop, 250-251
in iPhoto or Aperture, 249

text (Keynote), 236
in placeholders, 231
title text in slides, 220-221

requiring passwords
in AirDrop, 342
in email, 341
in exported documents, 346
in PDF documents, 345

reshape handles (Keynote), 235
resizing

charts (Numbers), 186
columns/rows in tables

Numbers, 150, 157
Pages, 67

graphics (Keynote), 257
photos (Pages), 83-85
text boxes (Pages), 55



366sharing

reviewing
comments (Keynote), 309-310
comments (Pages)

in Comments pane, 126-127
inline, 125

Track Changes (Pages)
in Comments & Changes pane, 

130-133
inline, 129

rotating photos (Pages), 83, 86
rounding callouts (Keynote), 235
rows in tables

Numbers, 142
alternating colors, 153
deleting, 150, 159
freezing, 158
header/footer rows, 145-146
hiding, 150, 159-160
inserting, 148
inserting in filtered tables, 201
moving, 147-148
resizing, 150, 157
selecting, 146-147
sorting specific rows, 199

Pages
coloring, 70
footers, 69
headers, 69
inserting, 64-65
resizing, 67
selecting, 60-61

Ruler, 38
formatting text (Pages), 48-49

running presentations (Keynote), 327-330
iPhone as remote control, 334-335
on iPhone/iPad, 350-351

S
saturation of graphics (Keynote), 259
saving

documents (iWork), 17-19
local versus cloud storage, 5-6
in Office compatible format, 26-27

styles
Keynote, 256
Numbers, 153
Pages, 53, 88

scratch, creating iWork documents from, 
15-16

searching photos (Pages), 80
sections (Pages), 111

formatting, 118
inserting, 117

security, passwords
documents (iWork)

assigning, 338-339
changing, 339
removing, 339

requiring
in AirDrop, 342
in email, 341
in exported documents, 346
in PDF documents, 345

sending, 342
shared documents

Keynote, 311
Pages, 134

selecting
cells (Numbers)

charts, 184
tables, 155

microphones, 32
tables (Pages), 60-61
within tables (Numbers), 146-147

sending passwords, 342
shadows

graphics (Keynote), 255
photos (Pages), 87

shaped text (Keynote), 230
inserting, 233-234

shapes (Keynote), 248
inserting, 266-268

shapes (Pages)
headers/footers, inserting, 107
inserting, 81

sharing
documents (iWork), 340

via AirDrop, 342-343
via email, 340-342
via iCloud, 343
via Messages app, 340
with other apps, 24-27

documents (Pages)
stopping sharing, 139
via iCloud, 122, 133-139
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documents (PDF) via email, 341
presentations (Keynote) via iCloud, 311
spreadsheets (Numbers) via iCloud, 207

sheets. See spreadsheets (Numbers)
shortcuts. See keyboard shortcuts
showing. See viewing
size limitations for email attachments, 342
sizing. See resizing
skipping slides (Keynote), 307
slides (Keynote)

builds, 272, 293-295
changing master slide for, 226-227
charts

formatting, 265
inserting, 263-264

deleting, 307
graphics

arranging, 261-262
editing, 257-260
formatting, 254-256
grouping, 263
inserting, 251-252
masking, 253-254
replacing placeholders, 249-251

inserting, 219-220
master slides, 210-212

changing, 214-217
viewing, 212-213

moving between, 328
object animations, 272

editing, 296-298
on/off slides, 286-287
removing, 298-299
within slides, 288-292

preparing for animation, 274
presenter notes, 243-245, 305
previewing animations, 276
reordering, 225
replacing title text, 220-221
shapes, inserting, 266-268
skipping, 307
tables, inserting, 266
text

arranging, 243
editing, 236
formatting, 234-242
inserting, 230-235
replacing, 236

titles, 229

transitions, 272
creating, 280-283
editing, 284-285
Magic Move transitions, 273-279

video/audio files, inserting, 269
view options, 221-224

Slideshow preferences (Keynote), configur-
ing, 313-314

slideshows. See presentations (Keynote)
sorting tables (Numbers), 197-198

with sorting rules, 199-200
spacing in Pages

paragraphs, 40-41
photos, 96

speech recognition (Pages), configuring, 
31-33

spell-check tools
Keynote, 305-306
Numbers, 205
Pages, 111-114

spreadsheets (Numbers), 141. See also 
documents (iWork)

calculations
deleting, 172
editing, 171-172
explained, 163-165
inserting, 166-171
repeating with AutoFill, 180
repeating with copy/paste, 181

charts, 183
configuring axes, 191-193
configuring data series, 194-195
copying to presentations (Keynote), 266
formatting, 187-188
inserting, 184-185
moving, 186
resizing, 186
selecting cells, 184
text formatting, 189-190

collaboration
comments, 205-206
sharing via iCloud, 207

formulas
changing relative/fixed cell 

references, 179
creating, 173-176
editing, 177
explained, 165, 172-173
relative versus fixed cell references, 178
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repeating with AutoFill, 180
repeating with copy/paste, 181

functions
building formulas, 173-176
explained, 165, 172-173

multiple sheets in, 160-161
spell-check tools, 205
tables

cell formatting, 150, 154-156
copying to presentations (Keynote), 266
creating, 143-144
deleting rows/columns, 150, 159
elements of, 142-143
filtering, 198-204
formatting, 144, 150-153
freezing rows/columns, 158
hiding rows/columns, 150, 159-160
inserting data in cells, 150-151
inserting headers/footers, 145-146
inserting multiple, 149
inserting rows/columns in, 148
merging cells, 150, 158
moving elements in, 147-148
moving within, 145
resizing rows/columns, 150, 157
selecting cells, 155
selecting within, 146-147
sorting, 197-200
styles, 145
text formatting, 150, 156

templates, 142
stopping sharing documents (Pages), 139
styles

Keynote, 234, 237-238
bulleted lists, 242
graphics, 255-256
presenter notes, 245

Numbers
charts, 187
saving, 153
tables, 145

Pages
applying, 30, 35-38
character styles, 42-43
creating, 44-45
defined, 36
deleting, 45, 89
grayed-out, 104
list styles, 46-47
naming, 42, 45

options, 45
overriding, 43
paragraph styles, 41-42
photos, 83, 87-88
Ruler and, 49
saving, 88
table of contents, 103
tables, 61-64, 68
text boxes, 52-53
updating, 43-44

synchronizing
iWork documents in iCloud, 8
out-of-sync documents, 22-23

T
table of contents (Pages), 100

changing, 104
deleting, 105
formatting, 103
inserting, 101-102

tables (Keynote), 248
inserting, 266

tables (Numbers)
copying to presentations (Keynote), 266
creating, 143-144
elements of, 142-143
filtering, 198-204
formatting, 144, 150-153

cell formatting, 150, 154-156
deleting rows/columns, 150, 159
freezing rows/columns, 158
hiding rows/columns, 150, 159-160
merging cells, 150, 158
resizing rows/columns, 150, 157
text formatting, 150, 156

inserting
data, 150-151
into documents (Pages), 74-75
headers/footers, 145-146
multiple, 149
rows/columns in, 148

moving
elements in, 147-148
within, 145

selecting
cells, 155
within, 146-147

sorting, 197-200
styles, 145



Index369 tables (Pages)

tables (Pages)
adding content, 59
contextual menus, 66
formatting, 61-64

adding columns/rows, 64-65
applying styles, 68
cell formatting, 70-72
customizing design, 69-70
resizing columns/rows, 67
text formatting, 72-73

inserting, 58
naming, 65
numbering, 66
positioning, 73
selecting, 60-61

tabs (Pages), setting, 48-49
tags, 17
templates, 13

creating iWork documents from, 13-15
Keynote, 210-211
Numbers, 142

text, Ransom Note Effect, 273
text (Keynote)

arranging, 243
editing, 236
formatting, 236-238

bulleted lists, 239-242
with styles, 234, 237-238

inserting, 230
callouts, 234-235
creating text boxes, 232
replacing in placeholders, 231
shaped text, 233-234

replacing, 236
title text, 220-221

types of, 229-230
text (Numbers), formatting

in charts, 189-190
in tables, 150, 156

text (Pages)
body text versus text boxes, 29
formatting, 30, 35-38

advanced options, 50
with character styles, 42-43
creating new styles, 44-45
as lists, 46-47
manually, 38-41
with paragraph styles, 41-42
with Ruler, 48-49

style options, 45
in text boxes, 51
updating existing styles, 43-44

inserting, 30
by copying/pasting, 34
by dictating, 33
by typing, 30-31

in tables, formatting, 72-73
text boxes (Keynote), creating, 232
text boxes (Pages), 50

body text versus, 29
formatting text in, 51
inserting, 51
positioning, 54-55
saving styles, 53
styling, 52-53

text wrapping (Pages)
photos, 95
text boxes, 54

themes. See templates
time. See date and time in headers and 

footers (Pages)
titles

table of contents (Pages), 101
tables (Numbers), 142

title text placeholders (Keynote), 211
replacing, 220-221

Track Changes (Pages), 122, 127
disabling, 133
enabling, 128
reviewing

in Comments & Changes pane, 
130-133

inline, 129
for shared iCloud documents, 134
versions of documents, 133

transitions (Keynote), 272
creating, 280-283
editing, 284-285
Magic Move transitions, 273-279

trendlines in charts (Numbers), 195
troubleshooting

calculations (Numbers), 169
managing out-of-sync documents, 

22-23
presentations (Keynote), acknowledg-

ing problems, 331
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sharing iWork documents with other 
apps, 25

two-display setup (Keynote), 326, 335
turning off. See disabling Track Changes 

(Pages)
two-display setup (Keynote), 312, 320

configuring, 322-323
with AirPlay, 323, 326-327
with cable, 322-325

troubleshooting, 326, 335
typing text (Pages), 30-31

U
unlocking graphics (Keynote), 262
updating

calculations in tables (Pages), 75
styles (Pages), 43-44

V
variables (Numbers), 164
versions of documents (Pages), 133
video, inserting

Keynote, 248, 269
Pages, 78

viewing
comments

Numbers, 206
Pages, 127

Comments & Changes pane (Pages), 
130

Comments pane (Pages), 126
documents (Pages), configuring 

options, 111-113
hidden rows/columns (Numbers), 150, 

159-160
Inspector, 34
Invisibles and Layout (Pages), 106, 112
master slides (Keynote), 212-213
multiple sheets (Numbers), 161
palettes (Pages), 119
presenter notes (Keynote), 243-245, 305
Ruler, 38, 48
slides (Keynote), 221-224

volume, changing, 32

W
Windows, accessing iCloud, 12
worksheets. See spreadsheets (Numbers)
wrapping text (Pages)

photos, 95
text boxes, 54

Z
zoom level (Pages), 113
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